Xilinx ISE 14.7 und ModelSim PE Student Edition 29.06.17

Installation Xilinx ISE 14.7 und ModelSim PE Student Edition 10.4 auf Windows 10

Vorbemerkungen und Problematik

Download und Lizensierung:

Die Nutzung der kostenlosen WebPack-Version der FPGA Design Suite Xilinx ISE 14.7
erfordert eine Lizenzdatei, die im Zuge des Softwaredownloads und der anschliefenden
Installation von Xilinx bereitgestellt wird. Diese besitzt eine unbegrenzte Giltigkeitsdauer.
https://www.xilinx.com/products/design-tools/ise-design-suite/ise-webpack.html

Der VHDL/Verilog-Simulator ModelSim PE Student Edition (aktuelle Version 10.4a) der Fa.
Mentor Graphics ist nur als 32-Bit-Version verfligbar.
https://www.mentor.com/company/higher _ed/modelsim-student-edition

ModelSim PE Student Edition erfordert eine Lizenzdatei, die im Zuge des Softwaredownloads
und der anschliefenden Installation bei Mentor Graphics kostenlos herunter geladen werden
kann. Diese Lizenz besitzt eine Giltigkeit von 180 Tagen.

Die FPGA Design Suite Xilinx ISE 14.7 muss aus Kompatibilitatsgriinden ebenfalls in der 32-
Bit-Version genutzt werden.

Vorteile des ModelSim VHDL Simulators gegeniiber dem Xilinx ISIM Simulator

e Strengere Priifung der VHDL

e Analoge Signaldarstellung

e Hohere Geschwindigkeit bei groRen Designs?

Nutzung unter Windows 10:

Die Xilinx ISE 14.7 ist nur flir Windows 7 zertifiziert. Fiir die Nutzung unter Windows 10 sind
nach der Installation gegebenefalls manuelle Eingriffe in das Installationsverzeichnis
erforderlich.

Die ModelSim PE Student Edition 10.4a ist unter Windows 10 lauffahig.

ModelSim PE Student Edition 10.4a ist ein Multi-Language Simulator, d.h. es kdnnen sowohl
VHDL- als auch Verilog-Projekte simuliert werden, aber keine gemischten VHDL/Verilog-
Projekte. Es ist kein Mixed-Language Simulator.

Integration von ModelSim in die Xilinx ISE:

Xilinx ISE 14.7 ist flr die Nutzung der ModelSim PE Student Edition vorbereitet.

Da ModelSim aber nicht komplett in die Xilinx ISE integriert ist, sind einige manuelle Eingriffe
in die Xilinx- und die ModelSim-Umgebung erforderlich, um ein sauberes Zusammenspiel zu
ermoglichen.

Um Xilinx-Projekte mit ModelSim simulieren zu kénnen missen die Xilinx-
Baugruppenbibliotheken in das von ModelSim bendtigte ausfiihrbare Format compiliert
werden.

o Dazu greift der Xilinx Simulation Library Compilation Wizard auf Routinen aus der
ModelSim PE Installation zu. Dazu mussen beide Programme auf entsprechende
Datei-Pfade zugreifen.

o Leider kann die Xilinx ISE mit dem feinen Namensunterschied zwischen der
ModelSim PE (Vollversion) und der ModelSim PE Student Edition im Namen und den
zugehorigen Verzeichnissen nicht umgehen. Deshalb ist hierzu die manuelle
Manipulation einiger Xilinx-Dateien und der ModelSim.ini erforderlich.
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Installation von Xilinx ISE 14.7 WebPack und ModelSim PE Student Edition 10.4a

1. |Installation von Xilinx ISE 14.7 WebPack

1.1. Download: Full Installer for Windows (TAR/GZIP - 6.18 GB)

1.2. Installation: https://www.xilinx.com/support/documentation/sw_manuals/xilinx14_1/iil.pdf

Im Installationsprozess sind folgende Eingaben erforderlich:
- Auswahl der WebPack-Installation

Select Products to Install

ISE 14.7 Installer - X

’ =l Edition List

\ ISE WebPACK

o}

" ISE Design Suite Logic Edition

" ISE Design Suite Embedded Edition
" ISE Design Suite DSP Edition

" ISE Design Suite System Edition

" Lab Tools - Standalone Installation

ISE 14.7 Installer

Welcome

Disk Space Required : 17480 MB
Accept License Agreements
-> Select Products to Install
Select Installation Options Description of ISE WebPACK
Select Destination Directory
Installation ISE WebPACK contains the most important tools you need for designing CPLDs and small to

medium-sized FPGAs. Includes: ISE Design Tools (w/reduced device support), PlanAhead,
Connectivity DSP IP. ChipScope Pro and The Embedded Development Kit will also be installed
with WebPACK but are licensed separately (not included in a WebPACK license file).

Copyright (¢) 19952013 Xiinx, Inc. All rights
reserved,

XILINX, the Xiirx logo and other designated
brands inchuded herein are trademarks of ik,

Inc, Al other trademarks are the property of
their respective owners,

- Auswahl der Installationsoptionen: License Key anfordern
- Die anderen Hakchen kénnen entfernt werden

ISE 14.7 Installer - X
€ Select Installatiohoptions

’ Select the desired installation options below. Selection of these options may result in additional

\ programs being run at the conclusion of the installation process.

Acquire or Manage a License Key
[ Install WinPCap for Ethernet Hardware Co-simulation

(]

ISE 14.7 Installer

Welcome J | |

Accept License Agreements

Selact Products to Install Select/Deselect All

-> Select Installation Options Description of Install Cable Drivers

Select Destination Directory

Installation Cable drivers are required to ensure proper operation of the parallel and USB cables when
configuring Xilinx devices. Please disconnect any Xilinx cables from your machine prior to driver
installation.

Copyright (¢) 1995-2013 Xiinx, Inc. All rights
reserved,

XILINX, the Xilinx logo and other designated
brands included herein are rademarks of i,
Inc. All other trademarks are the property of
ther respective owness.

€ Xilinx License Configuration Manager -

Acquire a License Manage Licenses ] Borrow/Restore Licenses Return Licenses Internet Settings ]
—Select one of the following options

" Start Now! - 30 Day Trial (No Bitstream)

¢ Get Free Vivado/ISE WebPack License

" Start 30 Day Evaluation

" Get My Purchased License(s)

" Locate Existing License(s)

Description of the above selected option

Get a free Vivado/ISE WebPack license and start using your Xilinx software. You will be taken to the Xilinx website where you can generate a license
for Vivado/ISE WebPack. Once your license file is generated, the "Manage Xilinx Licenses™ tab will open to enable you to configure your system to use

the license. For more information on Vivado/ISE WebPack, induding supported devices and applications, please visit www.xilinx.com.

Note: WebTalk is always enabled for WebPACK users. WebTalk ignores user and install preference when a bitstream is generated using the WebPACK
license. If a design is using a device contained in WebPACK and a WebPACK license is available, the WebPACK license will always be used. To change

this, please see Answer Record 34746.
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- Es wird ein auf den gerade genutzten PC zugeschnittenes kostenloses Lizenz-File erstellt
(notelocked license file).

& Xilinx License Configuration Manager X

Local System Information

Hostname: Win10vmRHD
Network Interface Card (NIC) ID: 000c29eb3b5f
C: Drive Serial Number: 36b7a848
FLEXID Dongle ID:

Connect Now | Save Infofmaﬁonl Cancel |

- Das Lizenz-File wird per Email zugesandt.

1.3. Installation des Lizenz-Files

Variante 1:
Beim ersten Start von Xilinx wird der Xilinx License Configuration Manager ge6ffnet.

Dort unter Load License das Lizenz-File einbinden.

- o X

§_ Xilinx License Configuration Manager
Acqurealicense  Managelicenses | Borrow/Restore Licenses | Retumlicenses | IntemetSettings |

Instructions: Click the “Load License” button to either load a response XML file into XLCM to activate your machine for Xilinx tools and IP, or copy a

o Pont to 3 floating server license, or to point to license files in locations other than .Xiinx, set one of the environment variables below. (Linux users wil
need to make these settings outside of this appication.) Examples: 1234@server; lic (Windows) or 1234@ser
(Linux)
XILINXD_LICENSE FILE |
Set
LM_LICENSE _FILE [
HIDDEN [V Hide Buit-n Free Licenses Clear Cache

Variante 2:
=> siehe obige Installationsanleitung
(https://www.xilinx.com/support/documentation/sw_manuals/xilinx14_1/iil.pdf)

Seite 31 (Node Lock License Installation)
Installing Your License Key File

The following subsections describe installing different types of licenses.

Node Lock License Installation

After generating a license file, you will receive an e-mail from
“xilinx.notification@entitlenow.com’.

1. Save the license file attached to the e-mail to a temporary directory on your local
system.
2. Run the Xilinx License Configuration Manager:

For Windows: Select Start > All Programs > Xilinx ISE Design Suite 14.1 >Accessories >
Manage Xilinx Licenses.

For Linux: Type x1em in a command-line shell.

w

. Click Copy License at the top of the Manage Xilinx Licenses tab.

IS

. Browse to your license file (xilinx.1lic) and click Open.

w

. This copies the license file to the ¢:\ .Xilinx (Windows) or <Home>/.Xilinx
directory of your computer where it will be automatically found by the Xilinx tools.

6. When the Copy License operation is complete, the table on the Manage Xilinx Licenses
tab is updated with licensing information from the license file.

7. Click Close to exit the Xilinx License Configuration Manager.

1.4. Anpassung der Xilinx Installation an Windows 10
Da Xilinx offiziell nur Windows 7 unterstitzt, liefert Xilinx fiir die Nutzung unter Windows 10
mit dem Support Artikel AR# 62380
ISE Install - Guide to Installing and Running ISE 10.1 or 14.7 on a Windows 8.1 or
Window 10 machine
eine ausfihrliche Anleitung:
e https://www.xilinx.com/support/answers/62380.html

Die notwendigen Anderungen beziehen sich aber nur auf die 64-Bit Version des ISE Projekt

Navigators und des Plan Ahead Tools.
Fir die hier genutzte 32-Bit Version sind keine Anpassungen notig.
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2. Installation der ModelSim PS Student Edition
2.1. Download, Installation und Lizensierung sind hier beschrieben:

https://www.mentor.com/company/higher _ed/modelsim-student-edition
Oder hier:
https://www.google.de/url?sa=t&rct=j&qg=&esrc=s&source=web&cd=6&ved=0ahUKEwi7pO
fVrovUAhWEVROKHS-
3AhUQtwIIUDAF&url=https%3A%2F%2Fwww.youtube.com%2Fwatch%3Fv%3DzdRt0_Oe9s
A&usg=AFQjCNFxHb92tusYPglyWwOyQA6Na7qfUw

Ein paar Bilder aus diesem Prozess:

[ Modelsim PE StudentEc X 4 - o x

&« > 0O Pl ttps://www.mentor.com/company/higher_ed/modelsim-student-edition = @ O

Menbr PRODUCTS  SOLUTIONS  TRAINING & SERVICES ~COMPANY BLOGS  SUPPORT (DS (@b

Higher Education Q

Company  Higher Education  ModelSim PE Student Edition

?tR ModelSim PE Student Edition

Careers Free download of industry leading ModelSim® HDL simulator for use by students ResouRces

in their academic coursework.

Consulting ModelSim Student
Services Edition
Executive Curriculum Support
Team
IC and ASIC Design Kits
Investor
Relations About ModelSim PE Student Edition Participating Schools
Office A
Highlights Target Use and Performance Contact Us
Locations & Upgrades
Worldwide « Support for both « Capacity: 10,000 lines FAQ
Distributors VHDL and Verilog + ModelSim PE Student of executable code
partners and designs (non-mixed). Edition is intended + berformance p to
Foundry + Intelligent, easy-to- for use by students in capacity): 30% of PE
use graphical user pursuit of their
Support grap! « Performance

academic coursework

Der erste Schritt besteht aus einer Anmeldung bei Mentor Graphics.
Dann folgt der Download:

ModelSim PE Student Editio

1. Download the latest ModelSim PE Student Edition| http://go.mentor.com/dTweZ
o Please note: You must be logged in as the administrator on the computer you are installing ModelSim PE Student Edition.

2. Install the Software

o After the file downloads completely, double-click on the _exe file to begin the installation process.
o You must agree to the Mentor Graphics End-User License agreement during installation to continue.
3. Complete the License Request Form

o Atthe end of the installation process, select Finish and a browser window will open with the License Request form
Please note - clicking on an existing license request link from your browser bookmark or from a link posted on the web - WILL NOT WORK.

o Complete the all of the form fields with attention to the email address field and submit the license request form

o Once your request has been received the ModelSim PE Student Edition license file will be generated, matched to your host computer and will be
emailed to you along with license installation instructions.
Please note - the license.dat file email could get reside in your Spam or Junk mail folder. If you do not receive the email within a few minutes,
check your spam folder or email provider.

o If you do not receive your license.dat file email - You will need to rerun the installation sequence and request a new license file. This is an
automated process. We are unable to manually generate a license file for you

about your
« License files are valid only for the current installation of the software on the computer on which the software is installed

« If you need to re-install the software on a computer, you are encouraged to download the latest release and corresponding license file.
o If for any reason you need a new license file - you must go through the entire process of download, installation and license request.

Dieser startet automatisch bei Aufruf obiger Adresse.
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Installation:

Setup for PE Student Edition 10.4a

Advanced Simulation and Debugging

wenthil LR

Choose Destination Location

Setup will instal ModetSim PE Student Edition 10.4a in the
folowing folder

Toinstal to this folder, cick Newt
To install to 3 diffecent folder, click Browse and select ancther
folder.

You can choose not o install ModelSim PE Student Edition 10.4a
by clicking Cancel to ext Setup.

Destination Folder
C:\Modekech_pe_edu_10.4a

AnschlieRend startet automatisch die Lizenzbeantragung.
Auch hier erscheint wieder ein Anmeldefenster.

- o X
@ http://portal.mentor.com/d/license_requ P~ & || @ ModelSim - Adva... % | B Willkommen bei Inte...
~
ModelSim PE Student Edition — License Request
Please complete the form below to have a license file emailed to you.
First Name * Last Name *
Email * Phone * (No Dashes or Spaces)
Email (Please Re-enter your email) * Flease veityyeer exail 83 the ModelSim Student Edic
‘ ‘ ‘emailed to you.
Address * Address 2
City * State/Province (US or Canada Only)
\ I V]
Country * Zip/PostCode *
[UNITED STATES v
Please tell us about yourself
Please specify your University, College, School, or Institute: *
Are you a Student or Instructor? *
OStudent OProfessor /Instructor O Other:[ |
If you are a student:
Please indicate your grade or position: *
O O G O other:
Freshman Sophomore Junior Senior Graduate Student
Expected graduation year: * v

Das mit folgender Meldung quittiert wird:

Thank you for downloading and installing ModelSim PE Student Edition.

Enclosed is your license key. In order to complete the installation you will need to carry out the FINAL INSTALLATION INSTRUCTIONS detailed below.

NOTE - Please note that this license key will only work on the host computer on which you ran the product installation; it is not transferable to any other computer.

FINAL INSTALLATION INSTRUCTIONS

1) Save the attached file with the name 'student_license.dat' to the top level installation directory for ModelSim PE Student Edition (e.g., c:/modeltech_pe_edu). This is the
directory that contains that sub-directory 'win32pe_edu.'

2) Do not edit the file 'student_license.dat' in any way, or the license will not work.

3) You should now be able to run ModelSim PE Student Edition.
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2.2. Setzen einer Environment-Variablen auf die ModelSim.ini Datei
o MODELSIM Pfad: C:\Modeltech_pe_edu_10.4a\modelsim.ini

=

« v A B3 Systemsteuerung > System und Sicherheit > System v & | Systemsteuerung durchsuchen ©

Startseite der Systemsteuerun . . - . 0
v 9 Basisinformationen Uber den Computer anzeigen
@ Gerite-Manager Windows-Edition

@ Remoteeinstellungen Windows 10 Education

© Computerschutz © 2015 Microsoft Corporation. -- Wl n d OWS 1 O
[ & Erweiterte Systemeinstellungen ] Alle Rechte vorbehalten. .

Computemame Hardware Erweitet Computerschutz Remote

Sie missen als Administrator angemeldet sein, um diese Anderungen

v & | "Modeltech_|
durchfiihren zu kénnen.
Leistung
Visuelle Effekte, Prozessorzetplanung, Speichemutzung und vitueller Benutzervariablen flir reinhold
Speicher Variable Wert A
Einstellungen.. NO_XILINX_DAT... HIDDEN
OneDrive C:\UsersVreinhold\OneDrive
Benutzerprofile PATH C:\Modeltech_pe_edu_10.4a\win32pe_...
Desktops igen beziiglich der Anmeld: TEMP USERPROFILE%\AppData\Local\Temp
— —
Starten und Wiederherstellen Systemvariablen
und D Variable Wert A
Siek ComSpec C:\Winlows\system32\cmd. exe
Sict Enstellungen... NUMBER_OF P... 1
os Windoffs_NT
Path C:\Winlows\system32;C:\W iCile
NelJ.. | Bearbeiten...| | Loschen
0K Abbrechen
S——— oK Abbrechen
L osver Neue Benutzervariable V X
[] RELEASE_NOTES

|2| RELEASE_NOTES.html
|=] RELEASE_NOTES.bt

T rbridant limamen A

Name der Variablen: | MODELSIM |

Wert der [ :\Modeltech_pe_edu_10.4a\modelsim. ini |

e

53 Elemente

2.3. Schreibrechte fiir die Modelsim.ini freischalten.
o Dazuvorher im Explorer die Sichtbarkeit von Dateiendungen bei bekannten
Dateitypen freischalten
Im Datei-Explorer => Ansicht => Ordner- und Suchoptionen
Im Folder Ansicht:

Ordneroptionen X

Aligemein  Ansicht  Suchen

Ordneransicht
Sie konnen diese Ansicht (z. B. . Details™ oder
.Symbole”) fur alle Ordner dieses Typs ubemehmen.

Fir Ordner Gbemehmen Ordner zunicksetzen

Erweiterte Einstellungen:

Dateien und Ordner A
Bei der Eingabe in der Listenansicht

(O Automatisch in Suchfeld eingeben

(® Eingegebenes Element in der Ansicht auswahlen
Dateigro Beinformationen in Ordnertipps anzeigen

Dateisymbol auf Miniaturansichten anzeigen

[[] Erweiterungen bei bekannten Dateitypen ausblenden

[ Freigabe-Assistent verwenden (empfohlen)

Geschutzte Systemdateien ausblenden (empfohlen)

[J Immer Meniis anzeigen

[ Immer Symbole statt Miniaturansichten anzeigen v
< >
Standardwerte
OK Abbrechen
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o Schreibrechte fiir die Modelsim.ini freischalten: Schreibgeschiitzt- Hikchen

entfernen

v = | C:\Modeltech_pe_edu_10.4a

4| M

m Start Freigeben

|
« . A
s Schnellzugriff
[ Desktop
& Downloads
|] Dokumente
&= Bilder
| @ OneDrive

[ Dieser PC

¥ Netzwerk
[ WIN1OVMRHD

Ansicht

Name

v e
verilog
verilog_src
vhdl_src
vhdlopt_lib
vital2.2b
vital1995
vital2000
vm_src
vovl_src
win32pe_edu
| ] .default_vopt_flow_on
|=| wversion.bdt
| LICENSE
£ modelsim.ini
| ] osver
| RELEASE_NOTES
|2| RELEASE_NOTES.html
—| RELEASE_NOTES.tt
| student_license.dat
| ] telfs

| veo

53 Elemente 1 Element ausgewahlt (88,9 KB)

> DieserPC > Lokaler Datentrager (C:) » Modeltech_pe_edu_10.4a

Anderunnsdatium n

Eigenschaften von modelsim.inj

Aligemein  Sicherheit Details Voffiangerversionen

o]

Dateityp:

Offnen mit:

Ort:

Groe:

GroBe auf
Datentrager:

Erstelt

Geandert:

Letzter
Zugrf

Atribute:

lmodelslm.lnl [

Konfigurationsginstellungen (ini)

-] Editor

Heutdl 27. Juni 2017, Vor 10 Stunden
Diegtag. 7. April 2015, 13:19:18
e, 27. Juni 2017, Vor 10 Stunden

Schreibgeschiitzt
[] Versteckt

et

2.4. Erganzende Nacharbeiten an der ModelSim Installation

= Ubersetzen der Xilinx Bauelemente-Simulationsbibliotheken in das vom Simulator

ModelSim bendétigte Format mit dem Xilinx Simulation Library Compilation Wizard:

Start > Alle Apps > Xilinx Design Tools > Simulation Library Compilation Wizard

Achtung:

Es muss der Simulation Library Compilation Wizard in der 32-Bit Version genutzt

werden.

Erlauterung:

Im Startmenii von Windows 10 werden die Apps nicht mit Verzeichnis-Hierarchie

aufgelistet und im Aufrufnamen ist die Information zur 32/64-Bit Version nicht enthalten.

€]
€]
)
&
e
|
@
@

Manage Xilinx Licenses
PlanAhead
PlanAhead (32-bit)

SDK Help Contents

Simulation Library Compila...

Simulation Library Compila...

Software Download Center
Timing Analyzer
Timing Analyzer

Uninstall

Alles auf einen Blick

Kalender

e

Microsoft Edge

Meist bewolkt

180 22:

Erst ein Klick mit der rechten Maustaste auf den Programmaufruf zeigt den vollstandigen
Pfad des Programmaufrufs:
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= Verknipfungstools ~Anwendungstools  32-bit Tools
Start Freigeben Ansicht Verwalten Verwalten
<« v 1‘[ <« Start Menu > Programs > Xilinx Design Tools > ISE Design Suite 14.7 > ISE Design Tools > 32-bit Tools l
# Schnellzugriff Name Anderungsdatum Typ GroBe
[ Desktop » ,.*,7 Constraints Editor 2 Verknipfung 2KB
; Downloads * ﬂ CORE Generator 2 Verkniipfung 2KB
E Dokumente * % FPGA Editor 2 Verknipfung 2KB
o Bilder . S Simulation Library Compilation Wizard 26.06.2017 17:54 Verknipfung 2KB
Timing Analyzer 2 Verknipfung 2KB
‘@ OneDrive ‘,.'d XPower Analyzer 26. Verkniipfung 2KB
[ Dieser PC
(&) DVD-Laufwerk (D:) VI
\j Netzwerk

- ]

v 0 32-bit Tools" durchsuchen

C:\ProgramData\Microsoft\Windows\Start Menu\Programs\Xilinx Design Tools\ISE
Design Suite 14.7\ISE Design Tools\32-bit Tools\Simulation Library Compiler Wizard

Falscher Pfad:

Einstellungen im

64-bit Tools

Detail:

Select Simulator

O 648

Simulator Executable Location command-ine option)
C:\Modetech_pe_edu_10.4a\win32pe_edu

&) Xilinx Simulation Library Compilation Wizard - Select Simulator

compxib cfg

compxib log

ModelSim/Questa Simulator 10.1a
Riviera 2010.10 or later
Active-HDL 8.3 or later

Compudib Configuration File (The -cfg command-ine option)

Compxdib Log File (The Jog command-ine option)

and later

< Back

Do not use this wizard For 1Sim or Mode!Sim Xiinx Ediion as they come with pre-compiled simulation libraries. Only specific versions of the simulators are supported. Please verify that the selected simulator
version satisfies the following requirements:

Next >

Select HDLs) used for simuiation
O Both VHDL and Verlog

@ VHDL

O Verlog

- Behavioral Simulation in VHDL
- Structural Simulation in VHDL
- Timing Simulation in VHDL

{8 Xilinx Simulation Library Compilation Wizard - Indicate the HDLs supported by your simulator

Please ensure that simulator is licensed for selected HDLs).

After compiation, the following types of simulations: can be perfomed

More info |

= ==
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& Xilinx Simulation Library Compilation Wizard - Select Device Families

Select Device Famies

(] Al FPGA Device Familes
[ Al CPLD Device Famiies
@ Atx7

@ Atix7 Low Votage

[ Automotive 9500XL

M Austomotive Ate7

4 Automotive CoolRunner2
@ Atomotive Spatan3

4 Automotive Spatan3A
4 Automotive Spartan-3A D.
@ Asomotive Spatan3E
4 Automotive Spartané

[ Automotive Zynq

[ CoolRunner XPLA3 CPLDs
@ CoolRunner2 CPLDs

M Kintex7

@ Kintex7 Low Votage

@ Spatan3

@ Spatan3A and Spartan3AN
M Spatan-3A DSP

@ Spatan3e

& Spatant

@ Spartant Lower Power
& Vitexs

@ Vitexs

@ Vitexs

(9 Vitex6 Lower Power

@ Vitex7

@ XC9500CPLDs

[ XC3500XL CPLDs

@ zmq

Als Standard sind hier die
Bibliotheken aller Xilinx-FPGAs,
SOCs und CPLDs aufgelistet.

Eine Reduzierungder Auswahl auf
die benétigten FPGAs ist sinnvoll.

oo | [t ]

8 Xilinx Library C

Wizard - Select Libraries
Select libraries for Functional and Timing Smulation

[ Allbraries

[ FPGA designs(UNISIM)

[ CPLD designs (COOLRUNNER UNIS000)

[ CORE Generator (XirxCoreLib)

[ Timing Smulation lbrary for FPGA and CPLD designs (SIMPRIM)

[ EDK Simulation Library

Auf die EDK Simulation Library kannin
dieser Lehrveranstaltungverzichtet
werden.

Specify more lbrary source path (The -source_lib command-ine option):

Specify more Compudib command-ine option:

Xilinx Simulation Library Compilation Wizard - Output directory for compiled libraries
ry Compi p ry p

drectory for lbraries

C:\Xiliro\14.7\ISE_DS\ISE\Jan >\<simulator>\s >\<platform> . .
— s e T ) Die Software setzt die konkreten

Pfadnamen automatisch ein.

[ Map onlyto existing pn (.e.now

d4ne option)

[0 Verbose (verbose)
Advanced options

You need to remove those entries in angle brackets  you are changing the location to something other than the defaut

Choosing Map only option is same as not including 4 argument in compxib

<Back

Launch Compie Process >

Default
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=

& Xilinx Simulation Library Compilation Wizard - Start Compilation - X

Compiling Simulation Libraries

Scheduling library installation & compilation for architectures: all ~
Scheduling library installation & compilation for libraries: simprim unisim coolrunner uni9000 xilinxcorelib

Signature:-

compxlib -s mti_pe -1 vhdl -arch all -1lib coolrunner -1ib uni9000 -1ib unisim -1ib xilinxcorelib -1ib simprim -w

Setting up the simulator 'mti_pe' for compilation ...
The executable path is set to 'C:\Modeltech_pe_edu_10.4a\win32pe_edu' ...
Setting up the source libraries for simulator 'mti_pe' ...

L Libraries for 'mti_pe' simulator
delSim PE Student Edition vcom 10.4a Compiler 2015.03 Apr 7 2015

=> 'C:\Xilinx\14.7\ISE_DS\ISE'

WARNING:Compxlib:312 - Output directory 'C:\Xilinx\14.7\ISE_DS\ISE\verilog\mti_pe\10.4a\nt' does not exist, it will b
Directory 'C:\Xilinx\14.7\ISE_DS\ISE\verilog\mti_pe\10.4a\nt' is created.

Library verilog.secureip will be compiled, because no precompiled info.
--> Compiling verilog.secureip library ...
> verilog.secureip library compiled from C:/Xilinx/14.7/ISE_DS/ISE/secureip/mti
> verilog.secureip library compiled to C:\Xilinx\14.7\ISE_DS\ISE\verilog\mti_pe\10.4a\nt/secureip

< Merkwirdigerweise erzeugt die Software trotz der Auswahl VHDL auch

F— Dateienim Verilog-Pfad!??? => Das stort aber nicht.
:  More Info poel

Wichtigster Teil des Protokolls:
Die Fehlerfreiheit der generierten Bibliotheken. Die Warnungen stéren nicht.

&) Xilinx Simulation Library Compilation Wizard - Start Compilation - X
Compiing Simulation Libraries
Restart

END_COMPILATION MESSAGES (mti_pe:vhdl:coolrunner)

> Log file 'C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/cpld/.cxl.vhdl.coolrunner.cpld.nt.log' generated
compxlib[vhdl.coolrunner]: 0 error(s), 1 warning(s), 100.00 % complete

t/modelsim.ini' ...

\Xilinx\14.7\ISE_DS\ISE\verilog\mti_p

COMPILATION SUMMARY

Compiled on: Tue Jun 27 13:27:50 2017

* Simulator used: mti_pe

............................................................................... N\

* Library | Lang | Mapped Name(s) | Exr#(s) Warn#(s) ~

* secureip | verilog | secureip 10 1 -

* unisim | vhdl | unisim 10 4 w

* simprim | vhdl | simprim |10 3 w*

* xilinxcorelib | vhdl | xilinxcorelib 10 358 =

* coolrunner | vhdl | cpld 10 1 "

v

< >

oo [T ] | s

Die generierten Dateien liegen im folgenden Pfad:

> C:\Xilinx\14.7\ISE_DS\ISE\vhdI\mti_pe\10.4a\nt
Der Protokollauszug enthalt u.a. den Text:
WARNING:Compxlib:312 - Output directory

‘C:\XiIinx\14.7\ISE_DS\ISE\vhdI\mti_pe\10.4a\.' does not exist, it will be created.

Directory 'C:\XiIinx\14.7\ISE_DS\ISE\vhdI\mti_pe\10.4a\.' is created.

In diesem Verzeichnis werden die compilierten Libraries abgelegt!

Library vhdl.unisim will be compiled, because no precompiled info.
--> Compiling vhdl.unisim library ...
> vhdl.unisim library compiled from C:/Xilinx/14.7/ISE_DS/ISE/vhdI|/src/unisims

> vhdl.unisim library compiled to C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/unisim

Prof. W.
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J[1=Int - 5 »
Start Freigeben Ansicht )
« v A || « Lokaler Datentrager (C:) > Xilinx > 147 > ISEDS > ISE > vhdl > mti_pe > 104a > nt > v P
# Schnellzugriff Neme Anderu T GroBe
[ Desktop ¢ cpld
& Downloads P simprim 7
=] Dokumente unimacro
&) Bilder unism :
silinkcorelib
‘@& OneDrive
[ Dieser PC

(&) DVD-Laufwerk (0:) VI

@ Netzwerk

Beachte: Falls der Verzeichnisname

C:\XiIinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\- lautet, wurde der falsche
Simulation Library Compilation Wizard (64-Bit Version) genutzt. Mit diesen Dateien

kann die 32-Bit ModelSin PE Student Version nicht umgehen.

2.5. Uberpriifen der Pfade zu den compilierten Simulationsbibliotheken in der ModelSim.ini

Datei: =>Pfad: C:\Modeltech_pe_edu_10.4a\modelsim.ini

[;{ *C:\Modeltech_pe_edu_10.4a\modelsim.ini - Notepad++ -

cHHBaRRBlsaDh ey 2% BRI EERa®| @E
[& modelsim.ini E3 IE modelsim.ini ,_il

Datei Bearbeiten Suchen Ansicht Kodierung Sprachen Einstellungen Werkzeuge Makro Ausfihren Erweiterungen

[m] X

Fenster ?

) B g

X

mtiUPF = $MODEL_TECH/../upf lib

mtiPA = $MODEL_TECH/../pa_lib
floatfixlib = $MODEL_TECH/../floatfixlib
mc2_lib = $MODEL_TECH/../mc2_lib

osvvm = $MODEL_TECH/../osvvm

; added mapping for ADMS
mgc_ams = $MODEL_TECH/../mgc_ams
ieee_env = S$MODEL TECH/../ieee_env

1 psl _checkers = $MO

psl_checkers // S
H checkers = ../verilog psl_checkers // S
smve 1i ODEL_TEC mve 1i

infact = SMODEL_TECH/../infact

og

vhdlopt_lib = $MODEL_TECH/../vhdlopt_lib

secureip = C:\Xilinx\14.7\ISE_DS\ISE\verilog\mti_pe\10.4a\nt/secureip

unisim = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/unisim

unimacro = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/unimacro

simprim = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/simprim
xilinxcorelib = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/xilinxcorelib
cpld = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/cpld

[El [DefineOptionset]|
; Define optionset entries for the various compilers, vmake, and vsim.
"-optionset <optionsetname>" syntax.

n sets can be used with the

-optionset COMPILEDEBUG top.sv
vsim -optionset UVMD G my_top

<

ource files only
ource files only

MSinifile length:91.499 lines: 2.035 Ln:83 Col:18 Sel:0|0 Windows (CRLF)  UTF-8

Falls die Pfade zu den compilierten Simulationsbibliotheken nicht in der
C:\Modeltech_pe_edu_10.4a\modelsim.ini angekommen sind, sind sie

INS

hdchstwahrscheinlich in der Datei: C:\Xilinx\14.7\ISE_DS\ISE\modelsim.ini gelandet

In diesem Fall miissen sie von Hand in die gewlinschte Zieldatei Gbertragen werden. Dabei

unbedingt die richtige Position beachten.

3. Verkniipfung von ModelSim PE Student Edition mit der Xilinx ISE Entwicklungsumgebung

3.1. In den Projekteinstellungen des zu bearbeitenden Xilinx-Projektes muss ModelSim-PE VHDL

als Simulator eingestellt werden.

Prof. W. Reinhold, HTWK Leipzig, FEIT

11



Xilinx ISE 14.7 und ModelSim PE Student Edition

29.06.17

Project > Design Properties

& |SE Project Navigator (P.20131013) - C:\Xilinx_Test\Test1\Test1.xise & Design Properties X
File Edit View IMI Source Process Tools Window Layout Help R [Tests |
O & H V| [l NewSource... APER2AR|IN Location: 2 \Wilnx _TestiTest1 |
Design & Add Source... Working directory: [cowiinx_TestiTestt |
[ |View: @ {8} in {§z] Add Copy of Source... Description:
] | Hierarchy New VHDL Library..
Eﬁ] e Manual Compile Order e
o Import Custom Compile File List... Property Name Valie)
L Top-Level Source Type [HoL v
& The vie Disable Hierarchy Reparsing
= You ““n Force Hierarchy Reparse Evaluation Development Board None Specified M
a m"’gm — Product Cateqory All v
2 using Cleanup Project Files... Family Spartan3 v
= Librarie . Device XC351000 v
m Archive... Package FG320 ™~
Use: Generate Tcl Script... Speed K v
PN = Synthesis Tool XST (VHDL/Verilog) v
N Simulator delsim-P v
I~ Design Summary/| rts
» _J £ Desig ry/Repo Preferred Lanquage VHDL >
= Property ion in Project File | Store all values &
k1 Manual Compile Order m]
) VHDL Source Analysis Standard [vHDL-03 ~
% Enable Message Filtering ]
-
o | ok el || eb
Edit > Preferences > ISE General Options > Integrated Tools
Z ISE Project Navigator (P.20131013) - C:Xilimy_Test\Test\Testxise
m View Project Source Process Tools Window Layout Help
Do undo Ctilez | »[222R 2RI =E 0=,
| Desgr CtrleY
i CtrleX
&l | copy CtrloC
G|y paste Ctrtev
&% Delete Del
31|04 Find.. CuleF & Preferences - Integrated Tools Options X
a Faiies = Category Set the paths for theintegrated toos you have instaled.
2 Find Previous Shift+F3 ropen =
= ||  Find&Replace... CtileH AT Browser Model Tech Smultor:
m 5 ISE General |C:\odeltech_pe_edu_10.4a\win32pe_edu\modelsim.exe. | | [cee] | Defoutt |
[ Findin Files Ctrle ShiftF  Design Gosls & Strategies
- Editors
§ Show Next Result Ctrl+F8
1| § ShowPreviousResult  Ctl+Shift-F !" Process Completon Notifcation [ [oee] [ oot
>  ISE Text Editor ‘Synpify Pro:
L Templates... Language Template
24 Q Language Templates. iy v [ [eee] | Defoutt |
;F Select All Ctri+A :‘ulmos;:;mce . Precision:
jew Object Colors .
= - Object Colors [ [on] [ oottt |
4 - User Color Rules Plenfhead:
_ & Schematic Editor
m Check [C:inx\14.7VSE_DS\PlanAhead\pin [ced] [ Defout |
Colors
 Device Families
- Layout
~ Printing
Sheet Sizes
& Symbol Editor
 Check.
" Colors
~ Timing Analyzer
3 5 % oo [0 e D | WebTalk v
Console [ cancel | [ aomy Hep
i

3.3.

Beheben des Versionskonfliktes zwischen der Xilinx ISE und der ModelSim PE Student
Edition beim Start des Simulators aus der Xilinx ISE

Die Xilinx ISE 14.7 unterstitzt nur die Integration der Vollversion von ModelSim PE.
Zur Integration der ModelSim PE Student Version ist ein manueller Eingriff in einige .rpt-
Dateien der Xilinx-Installation erforderlich.
Ohne diese manuellen Eingriffe erscheint die folgende Fehlermeldung:
The simulation libraries were compiled for the 'MTI_PE 10.4a' version, but the
selected simulator is 'MTI_PE Edition'. Please recompile the libraries for the selected
simulator version or change the simulator selection.
Ursache: Die wahrend der Compilierung der Simulationsbibliotheken eingetragene
Simulatorversion lautet ‘10.4a‘ (als Bestandteil des Stings * MTI_PE 10.4a‘“. Der Simulator
weist aber den folgenden String auf: ‘MTI_PE Edition 10.4a‘, wodurch beim Aufruf des
Simulators als zweites Element des Stings ‘Edition’ extrahiert wird.
Losung:
In einigen Dateien der compilierten Simulationsbibliotheken missen die fiir den Vergleich
genutzten Strings von ‘10.4a‘ auf ‘Edition’ gedndert werden.

Prof. W. Reinhold, HTWK Leipzig, FEIT
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Im folgenden Verzeichnis befinden sich die compilierten Simulationsbibliotheken:

| < Int
Start Freigeben

Ansicht
€« > v 'T“[ > DieserPC > Lokaler Datentrager (C) > Xilinx > 147 > ISEDS > ISE > vhdl > mtipe > 104a > nt > ]
~
# Sc Name Anderungsdatum Typ
[ Desktop * cpld Dateiordner
& Downloads * simprim Dateiordner
[ Dokumente * unimacro Dateiordner
unisim Dateiordner
&=/ Bilder * . ) i
xilinxcorelib Dateiordner
¢@& OneDrive
3 Dieser PC

Die gesuchten Dateien lassen sich Giber die Suchmaske rechts oben finden:

Eingabe in die Suchmaske: *.rpt

o = Suchtools  “.rpt - Suchergebnisse in "nt"
Start Freigeben Ansicht Suchen

Diese Dateien am besten mit einem Editor z.B. Notepad++ 6ffnen und in Zeile 6 die

Simulatorversion von “10.4a“ in ”-” andern.

Q{ CAXilinx\14.7\ISE_DS\ISE\vhdI\mti_pe\10.4a\nt\cpld\.gl.vhdl.coolrunner.cpld.nt.rpt - Notepad++

<« v A4 [ > Suchergebnissein "nt" > vo
- A
s Schnellzugriff \j .cxl.vhdl.coolrunner.cpld.nt.rpt Anderungsdatum: 27.06.2017 13:36
I Desktop » CAXilinx\14.7\ISE_DS\ISE\vhd\mti_pe\10.4a\nt\cpld ~ Typ: RPT-Datei GroBe: 637 Bytes
¥ Downloads  # U .exl.vhdl.xilinxcorelib.xilinxcorelib.ntrpt Anderungsdatum: 27.06.2017 13:36
[ Dokumente  # C:\Xilinx\14.7\ISE_DS\ISE\vhd\mti_pe\10.4a\nt\xlinx... Typ: RPT-Datei GroBe: 707 Bytes
=] Bilder * L-] .exl.vhdlsimprim.simprim.nt.rpt Anderungsdatum: 27.06.2017 13:35
C\Xilin\14.7\ISE_DS\ISE\vhd\mti_pe\10.4a\nt\simp... Typ: RPT-Datei GroBe: 646 Bytes
% OneDrive ’
. D .cxl.vhdl.secureip_vhdl_simprim.simprim.nt.rpt Anderungsdatum: 27.06.2017 13:35
[ Dieser PC CAXilind\14.7\ISE_DS\ISE\vhdl\mti_pe\104a\nt\simp... Typ: RPT-Datei Groke: 701 Bytes
¥ Netzwerk D .cxl.vhdl.secureip_vhdI_unisim.unisim.nt.rpt Anderungsdatum: 27.06.2017 13:34
[ WIN10VMRHD CA\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt\unisi... Typ: RPT-Datei GroBe: 687 Bytes
.cxl.vhdl.unisim.unisim.nt.rpt Anderungsdatum: 27.06.2017 13:34
C:\Xilinx\14.7\ISE_DS\ISE\vhd\mti_pe\10.4a\nt\unisi... Typ: RPT-Datei GroBe: 636 Bytes
U .cxl.vhdl.unimacro.unimacro.nt.rpt Anderungsdatum: 27.06.2017 13:34
| CVilind 147\SE DS\SEWhdmt_pe\104a\ntuni.. Typ: RPT-Datei | GroBe: 655 Bytes

Datei Bearbeiten Suchen Ansicht Kodierung Spfachen Einstellungen Werkzeuge

cHHERLB| Bk oefhy @x| B

|5 change log o4 [5 .od.vhdl.coolunner.cpld nt.mpt E3 I

=0T

Erweiterungen  Fenster

EpERpo® | @®D B

v O “nt" durchsuchen yel

ExecutionPlatform = nt ,

SourceLibrary = coolr r ,
SourcePath = C:/Xilinx
Simulator = mti pe

SimulatorVersion = 10.4a )

2
3
4
=
6

CompiledLibrary = cpld ,

Timestamp = Tue Jun 27 13:27:50 2017
Time = 1498562870 ,

Language = vhdl ,

XilinxBuildNumber = P.20131013 ,
XilinxVersion = 14.7 ,

NumOfErrors = 0 ,
16 NumOfWarnings = 1 ,

Details dazu finden sich unter

’

o http://www-classes.usc.edu/engr/ee-

.7/ISE_DS/ISE/vhdl/src/iSE/cpld ,

CompiledPath = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/cpld ,

k:leesult :C:\Xilinx\14.7\ISE PS\ISE\vhdl\mti_pe\10.4a\nt/cpld/.cxl.vhdl.coolrunner.cpld.nt.rpt

LogFile = C:\Xilinx\14.7\ISE_DS\ISE\vhdl\mti_pe\10.4a\nt/cpld/.cxl.vhdl.coolrunner.cpld.nt.log ,

s/201/Fall2011/Running_compxlib ISE13.1 mti_pe student_10.0a_USC.pdf in den

Punkten 2.16 ... 2.18

o Im Youtube-Video https://youtu.be/YMcOAAOnreQ ab dem Zeitpunkt 4:20

3.4. Viel Erfolg beim Arbeiten mit Xilinx ISE 14.7 und Modelsim PE Student Edition!
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